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Using Printer Profiles with Digital Labs 

This document assumes a familiarity with how to set up and use Photoshop's color management. If you are 
in doubt, please read either the brief tutorial on our site or one of the more extensive articles referenced in 
our list of resources. This also assumes you are using Photoshop version 6 or above. If not, get a new version. 
The price of a Photoshop upgrade is definitely worth the money for the time savings alone. If you use an 
image editing program other than Photoshop, make sure it supports converting image files to a printer 
profile. The basic flow is, however, approximately the same. 

If you are looking for custom Icc profiles for your printer and instructions on how to use them, please refer to 
our custom profiling section. 

 

Important note #1: All profiles assume an accurately calibrated and profiled monitor. The goal of printer 
profiles is to match your prints to your monitor. If the condition of your monitor is not known accurately, 
there is nothing to match the prints to. The viewing condition for the prints is also critical. Unless 
otherwise noted, our profiles are built for print viewing under industry standard D50 (~5000°K) 
illumination. 

 

Important note #2: Our digital lab profiles are created specifically for each individual printer. These are 
not generic profiles, nor should they be treated as such. Each printer and paper combination behaves 
differently. Using highly optimized profiles on a printer other than the one they were made for can result 
in worse performance than using no profile at all. 

 

After downloading the profile, you need to save it in a location that depends on what operating system you 
are using. The profiles are not compressed, as the files can't be squeezed down significantly. The profile files 
work equally well on Windows or Mac computers. Note that the profiles are binary files – they do not contain 
readily readable information. Image editing applications such as Photoshop and color printer drivers are 
equipped to use them. 

These locations are:  
• Mac OS X: Storing profiles in /Library/ColorSync/Profiles allows all users to use them. An alternative 

area, for users without Admin privileges, is /Users/<username>/Library/ColorSync/Profiles — any 
profiles stored here are available only to the current user.  

• Mac OS 9.x: System Folder:ColorSync Profiles  
o Mac OS 9.x users who have difficulty loading profiles in Photoshop, please read this note.  

• Windows XP, Vista: \Windows\system32\spool\drivers\color  
o The easiest way to install a profile in Windows XP is to right click on the profile and select "install 

profile". Windows copies the profile to the correct directory automatically.  
o Important note: If you are replacing a profile in Windows XP, the above shortcut does not work. 

The profiles must be manually copied to the correct directory for the original profile to be 
replaced.  

• Windows NT/2000: \Winnt\system32\spool\drivers\color  
o See above note for installing profiles in Windows XP - the same technique works in Windows 

2000.  
• Windows 98/ME: \Windows\System\Color  

  

http://www.drycreekphoto.com/Learn/profiles.htm
http://www.drycreekphoto.com/Learn/resources.htm
http://www.drycreekphoto.com/custom/customprofiles.htm
http://www.drycreekphoto.com/Frontier/FrontierDatabase.htm
http://www.drycreekphoto.com/Frontier/mac_os_9.htm
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Other applications supporting conversion to printer profiles: 

• QImage (Windows only): A powerful print and page formatting engine with a quirky user interface. 
At $45, QImage is a budget choice. Do not let the price fool you. If you can get past the interface 
oddities, you will find a program that excels at interpolating images, placing multiple images on a 
page, and basic editing. Versions 2003.228 and above have soft proofing capability. 

• CorelDRAW 10 and above: Corel apparently assumes that any RGB printer will be connected directly 
to your computer. Exporting a CMYK file is easy, switching between RGB profiles and rendering 
intents is not. A discussion of how to use profiles in Draw is beyond the scope of this document. 

• Picture Window Pro 3.1 and above (Windows and Linux only): A powerful image editor with ICC 
profile support. The profile conversion routines in Picture Window Pro (as of version 3.5.0.9) give 
mediocre results. Shadow details in particular are plugged up. Also, the match between soft proof 
and print is not as good as with the products listed above. 

 

Notable applications that do not support converting images to RGB printer Icc profiles: 

• Photoshop Elements (through version 3) 

• Jasc Paint Shop Pro (through version 9.0). 

• Corel Photo-Paint 

o We have a free, stand-alone utility to convert tiff images to a printer profile. It can be used in 
combination with one of the above image editors to perform ICC profile conversions. 

  

http://www.drycreekphoto.com/tools/profile_converter
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Example color managed editing and printing workflow 

The following work flow is a guide to using our  profiles and getting the best quality prints. It contains 
additional information specifically for Fuji Frontier, Noritsu QSS/DLS, and Agfa digital printers, as these are 
the ones most commonly found in labs. We erred on the side of completeness to help you achieve good 
results. 

1. Edit the image until you are happy and save the file. Do all your editing in a standard color space such 
as Adobe RGB or sRGB, not a printer profile. Editing color spaces are designed for editing. Printer 
color spaces are not. At this point you have an image that can be printed on any printer.  

2. Make a duplicate of the image. This allows you to keep the original as a printer-independent version, 
which can then be formatted for any other output medium. 

3. Select the duplicate, and open the Proof Setup dialog (View→Proof Setup→Custom). The 
screenshots below show the Proof Setup dialog boxes for multiple versions of Adobe Photoshop. 

4. Select the profile to use from the 
drop-down list in the Proof Setup 
dialog box. 

5. Check the Preview box and turn 
on Black Point Compensation to 
accurately scale the black level in 
your image to the printer's black. 

6. Do not select Preserve Color 
Numbers. This shows how your 
image would look if you did not 
do a color space conversion — 
just the opposite of what you 
want.  

7. Experiment with rendering intent. 
You can quickly switch between rendering 
intents in the Soft Proof dialog - just have 
the Preview option checked. Relative 
Colorimetric often gives the best results. 
Perceptual or Saturation can be better if 
your image contains many out-of-gamut 
colors. Absolute Colorimetric rendering is 
often used for mid-stage print proofing; if 
you are familiar with this, you don't need 
this document. 

o For most images Relative 
Colorimetric rendering produces 
superior results. For others, 
Perceptual will be far better. These cases include images with significant shadow details 
where a slight lightening of the print is acceptable to open up the shadows. Also images with 
areas of highly saturated color can benefit from Perceptual rendering. If you see color banding 
is the soft proof with Rel. Color. selected, try Perceptual. With experience you will get a feel for 
which images best pair with each rendering intent. 
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o Our newer profiles (August 2004 and later) feature a Saturation intent that is tuned to provide 
maximum useable saturation in the prints. If an image will benefit from increased saturation, 
give the Saturation intent a try. Most profiles either reserve the Saturation intent for 
PowerPoint-type graphics use or simply map it to the Perceptual intent. Our new profiles are 
designed to give photographers another technique to get the best prints possible. 

o Note: If you have setups that you use frequently, they can be saved using the "Save" button in 
the Proof Setup dialog. This makes the setting available directly from the View→Proof Setup 
menu. 

o If you wish to save a proof setup as the default, hold down the Alt/Option key. The "Save" 
button changes into "→Default". Push the button to save the selected proof setup as 
Photoshop's default. 

8. Simulation options:  
o These attempt to show the reduced contrast range the printed page will have vs. what your 

monitor can show. Without them you will have an over-optimistic view of the final contrast. 
o It is easiest to perform any major color and tonal adjustments without Simulate Paper Color 

(Photoshop CS2) or Paper White (Photoshop 6.0 through CS) or Ink Black checked. 
o The Simulate Black Ink (Photoshop CS2) or Ink Black (Photoshop 6 through CS) simulation 

should be checked to see if the shadow detail in your source image will hold up in print. This 
is particularly important for images with significant shadow detail. If your shadow details 
disappear, selective dodging can bring them back. 

o Simulate Paper Color/White attempts to show the effects of the difference between your 
monitor's white level and the (usually) less bright paper. This simulation is less accurate than 
the Ink Black, but can be helpful for ensuring critical highlight details hold up. 

 When you check the Simulate Paper Color box, the look of the image will likely change 
dramatically. This is an artifact of Photoshop trying to make the light emitted from 
your monitor match the look of light reflected from the printed page. The simulation 
works best if all white user interface elements (toolbars, palettes, etc.) are hidden. Use 
Photoshop's Full Screen mode for the most accurate view, and glance away as you 
switch the simulation on 

9. If you do not see significant changes when soft proofing, this is OK. This means your image contains 
colors that mainly lie within the printer's gamut. If the images do not match well enough, the 
following steps can help. 

10. Set the highlight and shadow points in the Levels dialog box. In Photoshop, hold down Alt/Option 
while adjusting the level sliders. This will show any shadow or highlight clipping that occurs. The 
ideal setting is usually the point right before clipping occurs. 

11. If the duplicate image that you are Soft Proofing looks greatly different from the original, minor 
curves or color balance adjustments are often all that are needed to bring things into line.  

o What's going on? The problem is that your monitor screen is capable of showing a much 
wider contrast range (usually 300x or more between black and white) than is the printed 
page. By adjusting the Soft Proof image you can visually compensate for some of the 
discrepancy. An intelligent levels adjustment, or slight boost to saturation is usually all it takes 
to give your prints the needed pop. 

12. An optional step is to check the image for out-of-gamut colors. Using a selected color range, you can 
(in order of preference) reduce the lightness, tweak the hue, or very slightly reduce the saturation to 
bring the problem colors within gamut. Note that all your edits are being performed in the file's 
editing color space rather than in the printer color space. This makes edits more predictable and 
controllable. 
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13. You're almost done. If you are using a Frontier. make sure your image is at one of the supported 
image sizes, and at 300 dpi. The sizes are (in inches): 4x6, 5x7, 8x10, and 8x12. Frontier 350 and 370 
machines can print up to 10x15. For example, a 4x6 image should be 1200x1800 pixels.  

14. Noritsu printers should be fed 400 dpi files for 2xxx MLVA series machines and either 300 or 320 dpi 
files for the 3xxx Laser series (see below). Noritsu files must have very close to the correct aspect ratio, 
e.g. 2:3 for a 4x6 print. Do not print files on a Noritsu with resolution higher than these values, or 
significant cropping may occur. 

15. Cropping: This is a problematic step for many photographers. The default printing mode crops a 
random (~0.1"/2mm) amount off one or more edges of your prints. If you do not have critical details 
near the edges of your shots, you can safely ignore the cropping. Other options include:  

o Ask for your files to be printed using the "No Resize" option. Most labs do not offer this option 
as it is incompatible with images that are not sized exactly. It is, however, the only way to get 
exact sizing.  

o Add some extra pixels to the canvas to compensate. A chart of suggested values for Fuji 
Frontier printers is given below. There are no exact dimensions to use for all printers, and you 
will find it varies a pixel or two with each new paper roll on the same printer.  

o Have your prints made with borders. This is useful only if you plan on matting the prints. Very 
few labs have their printers adjusted carefully enough to produce even borders.  

16. Finally, convert the image to the appropriate profile, using your chosen rendering intent. 
(Image→Mode→Convert to Profile). Frontier and Noritsu printers do not read embedded profiles, so 
the image data must be converted. This changes the data in the file to compensate for how your lab's 
machine actually prints colors.  

o If you were Soft Proofing with Simulate Paper White enabled, you will notice a sudden change in 
the image appearance. Photoshop turns off the Paper White simulation when you do a profile 
conversion. Do not worry - this will not change your print quality.  

o In the profile conversion dialog box, select the Use Black Point Compensation, Use Dither, and 
Flatten Image checkboxes, if available.  
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17. Save the file as an RGB jpeg or tiff. 

o Jpeg images saved at maximum quality will provide identical print quality to tiff images. Because 
of the smaller file size, they print much faster.  

o If using tiffs, they must be RGB mode 8-bit, uncompressed, and have no layers or alpha channels.  

o Do not embed the profile in the saved file. Frontier, Noritsu, and Agfa printers ignore embedded 
profiles, and sometimes can not process images with embedded profiles. In the File→Save As 
dialog box, uncheck the "Icc Profile:" box in the Color settings area. 

o If you are saving the file as a jpeg, use one of the "Baseline" format options. The "Standard" option 
works with all Printers. Support for the "Optimized" baseline format requires newer printer 
drivers. The Optimized format gives improved color rendition and smaller file size. The 
"Progressive" scan option will not print on most Frontier and Noritsu machines. Also, do not use 
the JPEG2000 format; this is not recognized by most current printer driver versions. 
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18. Instruct the print operators not to apply any of the automated image enhancement or adjustments 
to your files. Something along the lines of "send the files straight to the printer" usually works. If the 
lab operator is more technically savvy, request one of the following:  
o Fuji Frontier: No Corrections. A few labs use the PIC Pro module which allows printing in the 

"Import No Convert" mode. This gives a greater color range in saturated cyan tones. If the lab 
does not know what this is, or tells you that the mode is disabled, don't worry.  

 The FDIA/Image Intelligence auto-corrections and image enhancements must be disabled 
in the Frontier's driver module. 

o Noritsu: Digital Media Corrections disabled, DSA/Judgment Image Correction disabled. If you are 
printing from Compact Flash or other media that is not a CD, make sure the operators disable all 
the Digital Media Corrections options, not just the "Usual Media" option. 

o Agfa d-Lab: All dTFS corrections disabled. Use of Reproduction mode is not advised. Unless 
specifically identified, the profiles are not built for this mode. 

o Kiosks: Avoid these if at all possible — have the lab operators input your images directly into the 
printer console instead. Many labs find it easier to process files without corrections if the kiosk is 
not used. Most Frontier PIC and Noritsu QSS kiosk software automatically resizes and performs 
additional jpeg compression on all images sent through the kiosk. The goal is maintaining "good 
enough" image quality while speeding up print throughput. If you are going to the trouble of 
using ICC profiles and color managing your prints, you obviously are after something better than 
"good enough." 
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o Most Noritsu and some Frontier machines imprint a status string on the back of the prints that 
provides an indication of the print settings. If the status string exists, it may contain a series of 
numbers or letters, then the sequence N N N N followed by more numbers and letters. If any of 
the single "N" characters has a "+" or "-" sign following it, this shows one or more color channels 
was set to an adjusted value. For example if the string is N N N+2 N, one channel was bumped 
two notches. Tell the lab to reprint your files. This is also a useful check when you print files using 
a profile. Do not be concerned if there is no status string. Many labs do not print one.  

 Noritsu specific status strings: An example status string is as follows: 

8121 11  N N N N  NN   AC+02 Zxxx/xxx 
  [1]      [2]    [3]   [4]    [5]    

 Field [1] can contain any of a number of pieces of information, including date, order 
number, etc. None of this directly pertains to the printing mode. 

 Field [2] has the print color channel information. Values other than a single N, with no "+" 
or "-" sign, indicate that a print channel was adjusted. Have your files reprinted without 
corrections. 

 Field [3] should always be NN, "- - -", or simply not be present for digital media. It relates to 
the film scanner module settings. 

 Field [4] will often not be present. That is ideal, as it means no automatic adjustments were 
applied. If it does appear, the most common codes are "AC" and "AS" which stand for 
Automatic Contrast and Sharpening. If these, or any other code is present with a "+XX" 
value, ask for the target to be reprinted with all Media Corrections and DSA (Digital Scan 
Adjustment)/Judgment Image Correction settings disabled. Other auto-correction/DSA 
codes include SA, GR, and TC. 

 Field [5] contains print sizing data and may or may not be present. Its value does not 
matter from a color perspective, however it can be used to check the output resolution for 
Noritsu Laser printers. If no resizing is performed the field will have a value of 
Z100.0/100.0. The numerator will often not be exactly 100%; values from 99.7 to 100.3 are 
typical and reflect the sizing parameters used for that particular printer. There is no 
standard for Noritsu machines — most differ by a pixel or two in how large they assume a 
page is. For more details, see below. 

8121 11  N N N N  ---  Z100.1/100.0 
8121 11  N N N N  NN   Z106.7/100.0 

 Both examples above show typical Noritsu status strings when all autocorrections are 
disabled. The second string is an example of printing a 300 ppi image on an older Noritsu 
machine running at 320 ppi resolution. In most cases the scaling will not be visible; the 
internal Noritsu resizing algorithm is excellent. For maximum quality, however, you should 
pre-size your images to the native machine resolution and sharpen accordingly. 
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Suggested Fuji Frontier and Noritsu print sizes 
Notes:  

• Most labs have their printers set up to increase the size of each image by 1-2%. This expands the 
image beyond the borders of the paper. The reason is to prevent a white strip from being printed 
along one or more edges if the paper is not perfectly aligned within the feed path. 

• The default cropping is set to compensate for worst case paper alignment. Most labs have printers 
that are more carefully adjusted than this. The default level of cropping therefore often chops the 
edges off prints. 

• Cropping can be minimized by adding a thin border around the edges of each image (increasing the 
canvas size). When printed, the borders are cropped off, preserving more of your original images 

• The table below lists recommended dimensions for common print sizes to minimize normal 
cropping. These values are approximate. Each printer crops slightly differently, and exact cropping 
changes by a pixel or two each time the paper is changed. 

• Some Frontier labs will print using the "No Resize" option. If yours will, keep your files at the nominal 
size instead of expanding the canvas. 

• Be careful about increasing the canvas size too much. If you do, a thin, annoying white line will 
appear along one or more edges of your prints. It is usually better to have the machine crop slightly 
too much than too little. Otherwise, you are in for a long session with your Rotatrim. 

• For Noritsu printers the correct aspect ratio must also be used. There is also more variability in 
cropping from machine to machine than with Fuji Frontiers.  

o If your digital camera captures in the 4:3 (four thirds) format, make sure your lab supports 
these sizes. Many do not. If not, expand the image canvas to make the aspect ratio a 
supported size. Otherwise, the printer will perform severe cropping to the prints. 

http://www.amazon.com/gp/search?ie=UTF8&keywords=Rotatrim&tag=drycreekphoto-20&index=blended&linkCode=ur2&camp=1789&creative=9325
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Usage:  
• For Frontier printers, begin by setting your image to be an exact Frontier print size at 300 ppi. 

Example: for a 4x6 inch print, your image should be (4*300) by (6*300) = 1200x1800 pixels. Similarly, 
an 8x10 should be 2400x3000 pixels.  

• Use 400 ppi for Noritsu MLVA and Kodak DLS printers (Model number 2xxx) as well as Agfa d-Lab 
machines. For example, a 4x6 print on a Noritsu 2901 should be (4*400) by (6*400) = 1600x2400 
pixels. 

• Noritsu Laser printers (Model 3xxx) are problematic. Some machines print at 320 ppi, while Noritsu 
recently changed others to print at 300 ppi. There is no way to tell which resolution the machine runs 
at without making a print, nor does there appear to be any consistency as to which machines run at 
300 ppi and which ones use 320. If the lab can not tell you what resolution their printer uses, the 
safest course is to use the 300 ppi values in the table below for your first print order. Check the print 
sizing status string. If it says Z106.7/100 (or something close to 106.7), the printer is set to 300 ppi 
resolution. 

• Next, increase the Canvas Size in Photoshop (Image→Canvas Size) to the appropriate number of 
pixels based on the table below. Important: Do not increase the actual image size (Image→Image 
Size), as this produces the exact opposite effect from what we want. 

• Ask the lab to print using "Fill In" mode for Frontier printers, or "Cut" mode with Noritsu machines. 

Frontier print cropping setup 
Use "Fill In" print mode 

Noritsu print cropping setup 
Use "Cut" print mode 

Paper 
size 
(in) 

Paper 
Size 

(mm) 

Frontier 
Canvas Size 

(px) 

Noritsu 
Print Size (in)

Noritsu 2xxx
Canvas Size 

(px) 

Noritsu 34xx/3xxx 
Canvas Size (px) 

(300 ppi) 

Older Noritsu 3xxx
Canvas Size (px) 

(300 ppi) 

4 102 1228 4x6 1630x2446 1228x1842 1310x1964 

5 127 1524 5x7 2026x2836 1535x2149 1626x2276 

6 152 1818 6x9 2430x3646 1818x2727 1940x2910 

7 178 2138 8x10 3220x4026 2416x3020 2580x3226 

8 203 2434 8x12 3220x4830 2416x3624 2580x3870 

10 254 3036 11x14 4436x5646 3322x4228 3556x4526 

12 305 3638 12x18 4836x7254 3624x5436 3876x5814 
15 381 4536 12x24 n/a 3624x7248 n/a 
18 457 5440 12x36 n/a 3624x10872 n/a 
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• The table below gives maximum paper sizes for common photo lab printers. This is not an all-
inclusive list, and not all labs carry all dimensions of paper stocks. Ask your lab which paper sizes they 
offer. 

Printer Type Max. Paper Size (in) 
Fuji Frontier Models 

Frontier 330, 340, 390, 500 8x12 

Frontier 355, 370, 375 10x15 

Frontier 550, 570, 590 12x18 

Frontier 710 8x24 or 8x36 

 

Noritsu QSS Models 

2901, 30xx, 3101, 3111 12x18 

3411 (aka 34-Pro) 12x36 

 

Agfa Digital Models 

d-Lab.1, 2, 3 12x18 

Netlab.1 8x12 

Netlab.1 12x18 
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